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HUD Settlement Statements 

 

 
You may not reproduce, transmit, transcribe, store in a retrieval system or translate into any 
human or computer language this manual and software. These actions, in any form or by 
any means, are illegal without the express written permission of Puritas Springs Software. 

 
 

 

 
During the period of time before a major upgrade, if the disk(s) that make up the then-
current version of this software are defective, the original purchaser may return the software 
to Puritas Springs Software, 645 McKee Trail, Hinckley, Ohio 44233-9209 and replace-
ment disk(s) will be mailed to you. Puritas Springs reserves the right to define and decide 
what constitutes a major upgrade. 
 

 
 

Puritas Springs Software provides HUD Settlement Statements, consisting of both the 
software and this manual, "AS IS." The software and manual carry no warranty as to per-
formance, merchantability or fitness for any particular use. Puritas Springs Software spe-
cifically disclaims all warranties, express or implied, regarding the software or our services, 
and Puritas Springs Software does not warrant that the software or services are free from 
defects, interruption, errors or other program limitations. For states that have limitations on 
implied warranties, any such implied warranties are limited to 60 days from the date of pur-
chase. The rights provided by this Limited Warranty shall be limited to the original, regis-
tered and recorded purchaser of the software. Said rights are limited to the cost of the soft-
ware and are non-transferable.  You assume all liability and responsibility for the accuracy 
of any form produced by this software. Recognizing this, Puritas Springs Software has 
exercised due care in the preparation of the software and manual. In no event, however, 
shall the authors or publisher be liable for direct, incidental or consequential damages, or 
damages of any type, arising from the use of HUD Settlement Statements. 
 
This Agreement together with the Licensing Agreement you accept during installation sets 
forth Puritas Springs Software’s entire liability and your exclusive rights and remedy with 
respect to the software. Headings are included for convenience and shall not be considered 
in interpreting this Agreement. This Agreement does not limit any rights that Puritas 
Springs Software may have under trade secret, copyright, patent or other laws, federal or 
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HUD Settlement Statements—Version 3 
(WHUD3) is a true 32-bit Windows pro-
gram that runs on any computer equipped 
with Windows Vista/XP/2000/ME and 98 
operating systems. 
 
The WHUD3 distribution disk contains many files, some of which are shown below. 
You don't need to know anything specific about them. The installation program 
automatically transfers them to your hard drive and WHUD3 uses them during pro-
gram operation. The list below is for reference only. 
 
These files are essential to the proper operation of WHUD3. If any of these files be-
comes corrupted, you must reinstall WHUD3 from the distribution disk(s). Re-
installation will not affect your client HUD data files. Naturally, you should back up 
the data directory periodically to protect yourself. 

 
 

WHUD3.EXE is the executable file that is the WHUD program itself; 
 
WHUD3.CHM is a file that is used by WHUD’s on-line help system. It 

must always be in the same directory as the executable file; 
 
DEFAULT.HD3 is a necessary file that seeds any new client file you create 

in WHUD3. It must be located in the WHUD3 client file di-
rectory, usually C:\Puritas\WHUD3\Files. It should be set up 
by the user so it contains the personalized, normally un-
changing startup values for WHUD3.  

 
PAGEXX.DAT are a series of files numbered 1 through 17 that are used 

internally by WHUD3 to define the characteristics of the 
form answers. 

 
PAGEXX.RTF are a series of files also numbered 1 through 17 that are 

used internally by WHUD3 to create the actual forms that 
are displayed and printed. 
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In General 
 

Install HUD Settlement Statements—Version 3 
(WHUD3) to your hard drive by following the steps 
outlined below. Before starting the installation, we 
should mention that the files on the distribution CD 
are compressed, and therefore, you must “install” 
WHUD3 to your computer rather than simply copy-
ing the files from the CD to your hard drive. For that same reason, you cannot run 
WHUD3 from the CD. You must install WHUD3 to your hard drive. 
 
Installation Steps 

 
A.  Place the distribution disk in your drive. 
 
B.  Perform the following three steps to start the installation process: 
 

1. Press the Start button; 
 
2. Click on the Run item; and 
 
3. Type the command shown below. Note that if you’re installing from a dif-

ferent drive, you must use the correct drive letter. 
 

D:SETUP.EXE 
 
C.  The Setup progress meter will appear until the Welcome dialog appears. Click 

the Next button to proceed with installation. Click Cancel if you want to abort 
installation. 

 
D.  The Puritas Springs Software Licensing Agreement appears in the next dialog. 

Press the Yes button to accept the terms and conditions of the license and con-
tinue with the installation. If you do not agree to the terms of the Licensing 
Agreement, you will not be able to continue installing the program. 

 
E.  Verify your user identification information and click the Next button. 

 
F.  The Select Program Folder dialog lets you select the program folder . The de-

fault answer is “Puritas Springs Software”. Click on the Next button to continue. 
 
G.  The installation begins when you click the Next button in the Start Copying 

Files dialog. A progress meter will keep you informed as the program files are 
transferred from the CD to your hard drive. 
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I. The Setup Complete dialog advises you that the installation process was success-

fully completed. 
 
Running WHUD3 
 
To run the program, either double-click on the WHUD3 icon that is placed on your 
desktop by the installation process or click the item on your Start menu: 
Start|Programs|Puritas Springs Software|WHUD3. 
 
Updating and Reinstallation 
 

Periodically, based on changes in the law and program modifications, it will be neces-
sary to update your program. So long as updates are free, you can obtain them by fol-
lowing the three steps outlined below. 

1. Download the Upgrade. 

A. Click on WHUD3’s Help menu and select Download Upgrade. 

B. In the Download Upgrade dialog box, click on the Check Availability but-
ton. Note that some systems, typically networks, may have security software 
and/or hardware in place that prohibit downloading executable files. If this is 
true in your office or you are having problems with the download, check with 
your network administrator. 

C. After clicking the Check Availability button, you may get one of three re-
sponses. 

1) You are notified that a newer version is available and the Check Avail-
ability button changes to a Download Upgrade button. Click on 
Download Upgrade button and see the file downloading. 

2) You are notified that there is no newer version available, in which case, 
you’re done. 

3) A message indicates an error, i.e., “HTTP Get Failed.” Talk with your 
network administrator or send in your disk according to our instructions 
on the Current Versions page of our web site: www.puritas-
springs.com. 

2. Remove WHUD3. First, it is important to know that removing the WHUD3 
program using Windows’ Add/Remove function will not delete or harm 
your client files. That being said, you should always back up the Files subfolder 
that is contained within the WHUD3 program folder. It is there that your client 
files are stored. The default path is C:\Puritas\WHUD3\Files\. Here are the steps 
for removing the prior version of WHUD3. 

A. Exit the WHUD3 program. 

B. Click on the Start button. From the Start menu select Settings, and then 
Control Panel. Note that in some Windows versions, you may need to navi-
gate to Control Panel in a different way. However, once in Control Panel, 
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double-click the Add/Remove Programs icon. If you don’t see the Add/
Remove Programs icon, you may need to click on the Classic View link or 
option. 

C. Select WHUD3 from the program list within the Install/Uninstall tab. With 
the WHUD3 item highlighted, click the Add/Remove button. 

D. When the Welcome dialog appears, click the Next button to begin the re-
moval process. 

E. The next dialog box to appear is titled Program Maintenance. Click the ra-
dio button next the Remove item, and then click the Next button. 

F. Remove the Program is the next dialog box to appear. The InstallShield 
Wizard will begin to remove the old WHUD3 program when you click the 
Remove button. 

G. You are notified when the removal function is complete. In the dialog box that 
appears, click the Finish button to close the InstallShield Wizard 

3. Install the New Version. The final step in the upgrade process is to install the 
new version by executing the file you downloaded. The name of the downloaded 
file is setupwhud3.exe (note that sometimes the exe extension is hidden) and it 
is located by default at C:\Puritas\WHUD3\Files. When you find the file, dou-
ble-click on it and follow the installation instructions contained on page 4 of this 
manual. If you don’t know how to find the file, try following these steps: 

A Go to My Computer 

B Double-click the C:/ or Local Hard Drive icon. 

C Double-click the Puritas folder. 

D Double-click the WHUD3 folder. 

E Double-click the Files folder. The setupwhud3.exe file is in this folder. 
Double-click the file to begin installation. Don’t be fooled by the fact that 
Windows usually hides the exe extension. 
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When you start HUD Settlement Statements—Version 3 (WHUD3), it displays the 
Main Window. Your experience with WHUD3 will be more pleasant if you are fa-
miliar with the Main Window’s properties. The following information explains the 
Main Window in detail. 
 
The Main Window 
 
The Main Window has two components: a tree view and an instruction window. The 
tree view is composed of nodes and items. These components and terms are explained 
below. 
 
Tree View. The pane on the left side of the  Main Window contains a tree view of 
most of the forms and functions in WHUD3. You should be familiar with the look 
and feel of the tree view because it is a standard Windows component. You may rec-
ognize it as part of the Windows Explorer user interface. You can do two things in 
the tree view – click on nodes or click on items. Both are explained below. Note 
that if you ever cover the Main Window with a form and wish to see it again, you can 
click on the Main Window button on the button bar (also called the tool bar) or use 
the Display menu's Main Window command. You can also use the <F9> key to view 
the Main Window. The vertical divider (also called a splitter) that separates the left 
window from the right can be dragged horizontally to adjust the relative sizes of these 
windows to your liking. 
 
Nodes. Nodes are the [+] or [-] buttons you see in front of certain items in the tree 
view. The [+] sign means that there are elements or sub items within that item. You 
can view or expand the sub items by clicking on the [+]. When you do, you'll see the 
list of sub items and the [+] will change to a [-]. If you wish to collapse or hide the 
sub items, click on the [-]. Note that when you expand an item, its sub items may also 
have sub items. Even those sub items can have sub items. There's no limit to sub 
items in the tree view. You can see all of the items at the same time by right-clicking 
your mouse in the tree view and selected Expand Tree View from the pop-up menu. 
 
Items. Clicking on the items themselves will either 

(1) take you to a relevant instruction page like the one you're looking at right now, 
or 
(2) display a particular form that you wish to view or complete. 

 
The  Instruction Window. Start Here. Even though you can click on any item in 



8 

HUD Settlement Statements 

any order, we've arranged the first level of sub items in a top-to-bottom order that 
logically organizes the data entry process by building on information entered in prior 
levels. 
 
Step 1. Choose Settlement Statement. 
 
This is the starting point for new files. Select the HUD Settlement Statement that you 
want to work on (i.e., HUD-1 or HUD-1A). Make your selection by clicking on the 
appropriate item in the tree view. When you do, the settlement statement you selected 
will appear on your screen. 
 
When you first see the settlement statement, i.e., HUD-1, look carefully, the focus 
or input point is check box 1– Type of loan FHA. 
 
NOTE. Press � after every entry and to move from field to field on forms. 
 
It’s not necessary to take you through every entry. The pattern is simple. Make your 
entry and press �. You can check boxes by clicking your mouse or pressing the 
space bar. 
 
Here are several things to note about the settlement statement in particular and pro-
gram operation in general: 
 
• TAB & SHIFT TAB. Although you may discover that you can press the � 

key after each entry, we recommended you use � (TAB) after each entry. Note 
also, however, that if you hold the ���� key down when you press �, you can 
move the focus backwards. 

 
• There’s two types of text input boxes you’ll encounter as you tab through the 

fields of a form on your screen: 
 

• Normal Text Input Boxes. The normal box has a silver/gray background. 
Most answers use this type of box. Whatever you enter will appear in that 
location on the form. Line 101 Contract sales price is a good example. 
If the sales price is $150,000.00 you’ll enter 150000 and press the �key. 
The correct amount appears on the line and that’s all there is to it. While 
we’re on the subject of these boxes, you’ll also notice that some lines have 
no box. Line 103 Settlement charges to borrower (line 1400) is a 
good example. Line 103 is completed by WHUD3 based on your total 
from page 2, line 1400. There aren’t any circumstances where line 103 
won’t equal line 1400, so WHUD3 doesn’t even let you make an entry on 
line 103, it completes line 103 itself based on your entries on page 2. 

 
• Overrideable Text Input Boxes. The second type of box has a light blue 

background. These boxes are called overrideable text input boxes and rep-
resent a special situation where WHUD3 will attempt to answer these 
fields automatically, however, if you wish to change the answer, you can 
go to the Options menu and Override the answer, thereby superseding 
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the WHUD3-supplied answer and entering your own. A good example of 
an overrideable box can be found on page 2, the signature lines that are 
explained in more detail in the next item. You override an answer by 
moving the focus to it and then selecting Override on the Options 
menu, or double-clicking in the text input box or by pressing the � �  
key combination. 

 
• In the Name and Address of Borrower set of fields, Section B Type of 

Loan, box D, the first field in the box populates the borrower signature lines at 
the bottom of page 2. If you have only one name, WHUD3 will transfer that 
name automatically to the first signature position. If you have two borrowers, 
i.e., “John H. Smith and Mary P. Smith,” WHUD3 will attempt to intelligently 
parse the names and put the first name in the first signature position and the sec-
ond name in the second position. Due to the infinite variety of names and render-
ings, always check this transfer. Note in this context that you can enter the bor-
rowers' names any way you like because the signature lines can be overridden in 
any event. 
 

• The Name and Address of Seller set of fields works the same way as ex-
plained for the borrower. 
 

• Certain fields like Line 103 cannot be entered because they calculate automati-
cally based on other entries. Line 103, for example, will populate when you 
complete page 2 of the HUD-1 form. The lines near the bottom of the form rep-
resenting various totals behave the same way—they calculate automatically and 
you cannot enter those fields. 
 

• When you tab to the fields for lines 106, 107, 108, you may notice that the Pro-
ration Table button label turns red. This is a little reminder that you do not need 
to manually calculate and override these lines. Instead you can click the Prora-
tion Table button and let WHUD3 do the math. See Step 3 below for more in-
formation about the Proration Table. 

 
• The following fields also work the same way in connection with the Prora-

tion Table: 210, 211, 212, 406, 407, 408, 510, 511, and 512. 
 

• Dollar Amounts. Enter dollar amounts without using dollar signs or commas. 
NOTE: You can also type a word in where the dollar amount goes. This might 
be done in situations where the borrower pays insurance and property taxes sepa-
rately and not as part of the mortgage payment. In those instances, many lenders 
will type the word “Direct” in the area where the amount goes. This is perfectly 
acceptable and will not cause problems. Naturally, the “amount” on that line will 
be counted as zero. However, if you intend to enter a dollar amount, do NOT 
use commas or dollar signs. 

 
• Verbosity. This and legal authoring go hand-in-hand. Text input boxes will usu-

ally let you enter much more text than will fit in a particular area (what computer 
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literates refer to as a “field”) of the form. The forms themselves are carefully 
crafted RTF files that leave an arbitrarily-determined-adequate amount of space 
for answers. Be aware that if you try to squeeze in more information than will 
comfortably fit, you may skew the careful formatting of the RTF file making the 
screen and printout look abnormal. Remember this when making your entries 
and when changing fonts, font sizes, etc. 

 
• Percentages. Enter percentages as whole numbers, for example, enter three per-

cent (3%) simply as the number ‘3.’ 

 
• Finally, there are paging button(s) at the top of the screen to move from page to 

page, i.e., the HUD-1 form is three pages long. 
 
• Certain Overrideable Lines. Example: 1002. Homeowner’s insurance. On 

Form HUD-1, page 2, line 1002 WHUD3 performs the total months times dol-
lar-per-month automatically. WHUD3 cannot ascertain, however, whether the 
charge is being paid from the borrower’s or seller’s funds because often times 
that amount varies according to the parties’ agreement. Therefore, WHUD3, by 
default, will place the result of the calculation in the borrower’s column. If you 
wish the results of the calculation to be in the seller’s column, simply override 
(see the override explanation above) the borrower’s column and the amount will 
automatically transfer to the seller’s column. Note that line 703 Commission 
paid at settlement defaults to the seller’s column. 

 
Step 2. Name & Save The File 
 
When you’ve completed the settlement statement, it’s a good idea to save your file 
and give it a name. Look at the title bar on your display and you’ll notice that we 
haven’t named the file yet. We are reminded of that fact on the title bar where it says 
NONAME. It’s not wise to work in your file too long without giving it a name and 
saving it. Now is an excellent time to do that. To save the file and give a name, 
you’ll want to use the File|Save As command, simply click on the Step 2 item in 
the Main Window. You may use any valid Windows file name, but by all means, use 
the HD3 extension, or better yet, leave it off and let WHUD3 add it automatically. 
Once the file has a name, you’ll see it on the window’s title bar. Avoid using the 
File|Save As command once you’ve given your file a name. Use the Save but-
ton on the button bar to save file changes AFTER you’ve used the Save As 
command to name the file. 
 
To recap, here’s two worthwhile rules to keep in mind when saving files: 
 
1. Always use the extension HD3. If you simply type the file name and don’t type 
the period and extension (HD3), the WHUD3 will attach the extension automatically 
and this is probably the easiest course to follow. 
 
2. Save your client files in the default WHUD3 directory (C:\Puritas\WHUD3
\Files\). WHUD3 is designed to open and save files to a single directory where all of 
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the client files can be found. You can set the default directory using the appropriate 
command on the Options menu, but once you set the default location, it is best to 
use only that location for all your client files. 
 
Step 3. Display/Complete Other Forms 
 
Once you’ve completed the Settlement Statement and named and saved your file, 
you may want to display the other pertinent forms and manually enter any informa-
tion that hasn’t automatically populated the forms from the completed Settlement 
Statement. All the remaining forms are available from this level of the tree view. 
 
Proration Table. On this form you can enter specific starting and ending dates 
along with an amount and the period which that amount covers. WHUD3 will then 
calculate the prorated amount. For example, if annual real estate taxes were 
$3,600.00 and you wanted to know how much would accrue between January 1st 
and February 15th, you would make the following entries in the appropriate column: 
 
 Starting date   1/1/09 
 Ending date   2/15/09 
 Amount to be prorated 3600.00 
 Period    Annual 
 
Using line 106 as an example, when you make your entries, you’ll notice that the 
rightmost column will automatically contain the prorated amount (in this case 
$453.70). Furthermore, that amount, along with the starting and ending dates, will 
automatically transfer to page 1, line 106 of the HUD-1 Settlement Statement. 
 
Step 4. Save File Again 
 
Another reminder to save your work. You won’t see much happen when you click 
here because the file has already been named, so all it’s doing is resaving your 
changes. It happens so fast, you might think nothing’s happening. 
 
Step 5. Printing the Forms 
 
The Settlement Statement is available to be printed in several variations. They are all 
self-explanatory and available on the File menu’s Print submenu as well as the hier-
archy of sub items in the tree view of the Main Window. Be aware that any form 
that can be printed can also be sent to your word processor in the event you wanted 
to make certain custom changes to the final forms. 
 
Step 6. Sending Forms to Your Word Processor 
 
Clicking on this item also exposes a hierarchy like the Print item from which you 
can send any single-page or multi-page form and send it to your word processor. 
There WHUD3 works best with Microsoft's Word for Windows, but can be used 
with any word processors capable of handling rich text format (RTF) files. When it 



12 

HUD Settlement Statements 

ships, WHUD3 is set to use Word for Windows. If you need to use a different word 
processer, you can go to the Options menu's Set Word Processor function to 
make the necessary adjustment. Word’s printing functions are so extensive that al-
most any requirements can be met using this function. Some users use it in place of 
the Print function. 
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This paper manual is merely an outline of the basics of installation, getting started 
and data entry. From there, you can get help via the program’s Help|Table of Con-
tents menu. This program has context-sensitive help. That means that you get help on 
a specific topic without searching for that topic. 
 
Some dialogs have a help button. Clicking on the help button brings up an associated 
help topic that should clear up any questions you have about the entries you would 
make in that dialog. Menu items have context sensitive help too. You can access help 
on menu items by navigating to the menu item in question using the keyboard and, 
while the subject menu item is highlighted, pressing your � key. Another useful 
feature of WHUD3 is that when an error message or warning is displayed, in 
many instances the notice has a Help button that will take you to a related help 
topic explaining the error or warning. 
 
If you’re like us, you might be doubtful as to whether help files can be truly helpful. 
Regardless of  any drawbacks, we found them to have significant benefits over their 
paper counterpart. 
 
Help Is Always There 
When we were at the office, the manual was at home. When were on the computer at 
home, the manual was at the office. On unfortunate occasions, that alone can make 
you lose a day. It never happens with help files. They’re always there. A copy for 
your home computer, and a separate one for the office. Ditto for your laptop! When 
you’re desperate for information, you can always count on its accessibility. 
 
Help Is Hyperlinked, Searchable & Better Indexed. 
We took extra time to develop a logical system of indexing. You should find that a 
help file’s searchability can be a time-saver when you’re looking for a snatch of text. 
The point and click links between key words provide instant information without 
fumbling though page after page looking for something. This non-linear characteris-
tic is part of what makes help files so uniquely useful. 
 
Help Is Up To Date 
Because they are printed in larger quantities, paper manuals fall out of synch with 
last-minute or late-minor programming changes during the duration of the “printing.” 
Help files, on the other hand, are easier to keep current with programming changes 
because their modification involves no additional processing steps to implement (i.e., 
physical transportation, printing, binding, etc.). 
 
Paper Fix 
Don’t forget that any help topic can be printed simply by pressing the help window’s 
Print button, or using the menu’s Print Topic command. 
 
 


